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What is Symantec Encryption Desktop? 

Symantec™ Encryption Desktop provides comprehensive 
security for desktops and laptops, making it possible for 
enterprises, workgroups, and individuals to protect sensitive 
information without changing the existing IT infrastructure 
or disrupting work processes. This award winning, 
easy-to-use solution encrypts email, files, virtual volumes, 
and entire disks from a single desktop application. 

Symantec Desktop Email Encryption 
Use Symantec Desktop Email Encryption to automatically and 
transparently encrypt, sign, decrypt, and verify email 
message through policies you defined for you by 
administrators, or policies you control if you are not part of a 
Symantec Encryption Server-managed environment. 

Symantec File Share Encryption 
Use Symantec File Share Encryption to let authorized users 
share protected files in a shared space--such as a file server, 
shared folder, or USB removable drive. 

Symantec Drive Encryption 
Symantec Drive Encryption is used to lock down the entire 
contents of your system or an external or USB flash drive you 
specify. 

In addition, use Symantec Encryption Desktop to: 

Use part of your hard drive space as an encrypted virtual
disk volume with its own drive letter.

Create protected Zip archives.

Completely destroy files and folders so that nothing can
recover them.
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New to Symantec Encryption Desktop? 

Use this step-by-step guide to get started. You will find that, 
with Symantec Encryption Desktop, protecting your data will 
be as easy as turning a key in a lock. 

This Quick Start Guide helps you install Symantec
Encryption Desktop and get started.

The Symantec Encryption Desktop User’s Guide provides
more detailed information on Symantec Encryption
Desktop. In it, you will learn what a keypair is, why you
might want to create one, how to create one, and how to
exchange keys with others so you can encrypt your own
data and share data securely with others.

Note: A Symantec Encryption Desktop license provides 
you with access to a certain set of Symantec Encryption 
Desktop features. Certain other features of Symantec 
Encryption Desktop may require a different license. For 
more information, see the Licensing section of the 
Symantec Encryption Desktop User’s Guide. 

For deployment, management, and policy enforcement
information for Symantec Encryption Desktop, see the
Symantec Encryption Server Administrator’s Guide.

Understanding the Basics 

Symantec Encryption Desktop uses keys to encrypt, sign, 
decrypt, and verify your messages. 

After installation, Symantec Encryption Desktop prompts you 
to create a PGP keypair. A keypair is the combination of a 
private key and a public key. 

Keep your private key and its passphrase private, as the
name suggests. If someone gets your private key and its
passphrase, they can read your messages and
impersonate you to others. Your private key decrypts
incoming encrypted messages and signs outgoing
messages.

Your public key you can give to everyone. It does not have
a passphrase. Your public key encrypts messages that
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only your private key can decrypt and verifies your 
signed messages. 

Your keyring holds both your keypairs and the public keys of 
others, which you use to send encrypted messages to them. 
Click the PGP Keys Control Box to see the keys on your 
keyring: 

1 The icon for a PGP keypair has two keys, denoting the 
private and the public key. Alice Cameron has a PGP 
keypair in this illustration, for example. 

2 The icons for the public keys of others have just one key. 
Ming Pa’s public key, for example, has been added to the 
keyring shown in this illustration. 

 
 

 

What Am I Installing? 

Symantec Encryption Desktop uses licensing to provide 
access to the features you purchase. Depending on the license 
you have, some or all of the Symantec Encryption Desktop 
family of applications will be active. 

This document contains instructions for viewing the features 
activated by your license. 

Symantec Desktop Email Encryption is a member of the 
Symantec Encryption Desktop family of applications. You can 
use Symantec Desktop Email Encryption to automatically and 
transparently encrypt, sign, decrypt, and verify email 
messages through policies you control. Both users must have 
Symantec Desktop Email Encryption enabled. 

PGP Viewer is a member of the Symantec Encryption Desktop 
family of applications. You can use PGP Viewer to decrypt, 
verify and display email messages outside of the mail stream. 
You can also use PGP Viewer to decrypt and view legacy 
IMAP/SMTP/POP email content. 

Symantec File Share Encryption is a member of the 
Symantec Encryption Desktop family of applications. You can 
use Symantec File Share Encryption to authorize users to 
share protected files in a shared space, such as on a corporate 
file server, in a shared folder, or on a removable media such as 
a USB drive. The encrypted files in the Protected Folder 
continue to appear as normal application files to the 
authorized users; anyone else with physical access to the files 
can see them but not use them. 

Symantec Drive Encryption is a member of the Symantec 
Encryption Desktop family of applications. You can use 
Symantec Drive Encryption to lock down the entire contents 
of your system or an external or USB flash drive you specify. 

Boot sectors, system files, and swap files are all encrypted. 
Encrypting your boot drive means you do not have to worry if 
your computer is lost or stolen: to access your data, an 
attacker would need the appropriate passphrase. 

PGP Virtual Disk volumes use part of your hard drive space 
as an encrypted virtual disk volume. A PGP Virtual Disk is the 
perfect place for storing your sensitive files; it is as if you 
have stored them in a safe. When the door of the safe is open 
(when the volume is mounted), you can change files stored in 
it, take files out of it, and move files into it. Otherwise (when 
the volume is unmounted), all the data on the volume is 
protected. 

PGP Zip adds any combination of files and folders to an 
encrypted, compressed, portable archive. Symantec 
Encryption Desktop must be installed on a system to create or 
open a PGP Zip archive. PGP Zip is a tool for securely 
archiving your sensitive data, whether you want to distribute 
it to others or back it up. 

PGP Shredder completely destroys files and folders so that 
even file recovery software cannot recover them. Deleting a 
file using the Windows Recycle Bin (on Windows systems) or 
Trash (on Mac OS X systems) does not actually delete it; it sits 
on your drive and eventually gets overwritten. Until then, it is 
trivial for an attacker to recover that file. PGP Shredder, in 
contrast, immediately overwrites files multiple times. This is 
so effective that even sophisticated disk recovery software 
cannot recover these files. This feature also completely wipes 
free space on your drives so your deleted data is truly 
unrecoverable.  

Key Management manages PGP keys, both your keypairs and 
the public keys of others. You use your private key to decrypt 
messages sent to you encrypted to your public key and to 
secure your PGP Virtual Disk volumes. You use public keys to 
encrypt messages to others or to add users to PGP Virtual 
Disk volumes. 
 

Installing Symantec Encryption Desktop 

Symantec Corporation recommends exiting all open 
applications before you begin the install. The installation 
process requires a system restart. 

Note: If you are in a domain protected by a Symantec 
Encryption Server, your Symantec Encryption Server 
administrator may have preconfigured your Encryption 
Desktop installer with specific features and/or settings. In 
addition, if your Symantec Encryption Server administrator 
set up silent enrollment, your Windows domain password 
will be used for all passphrase requirements in Symantec 
Encryption Desktop. If specified by policy, Symantec Drive 
Encryption may automatically start to encrypt your disk 
when your Windows password is entered. 

To install Symantec Encryption Desktop 

1 Locate the Symantec Encryption Desktop installation 
program you downloaded. 
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The installer program may have been distributed by your 
Symantec Encryption Server administrator using the 
Microsoft SMS deployment tool. 

2 Double-click the installer. 

3 Follow the on-screen instructions. 

4 Reboot your system when instructed. 

5 When your system restarts, follow the on-screen 
instructions to configure Symantec Encryption Desktop. 

 

 

Licensing 

To see what features your license supports, open Symantec 
Encryption Desktop and select Help > License. Those features 
with a checkmark are supported by the active license.  
 

Starting Symantec Encryption Desktop 

Note: For information on how to start and use Symantec 
Encryption Desktop on Microsoft Windows 8/8.1/10 
systems, see "Conventions Used on Windows 8/8.1/10 
Systems" in the Symantec Encryption Desktop User’s Guide. 

To start Symantec Encryption Desktop, use any of the 
following methods: 

 Double-click the PGP Tray icon. 

 

 Right-click the PGP Tray icon and then select Open 
Symantec Encryption Desktop. 

 From the Start menu, select Programs > Symantec 
Encryption > Symantec Encryption Desktop. 

 

The Symantec Encryption Desktop Main 
Screen 
The Symantec Encryption Desktop application window is your 
main interface to the product. 

 

The Symantec Encryption Desktop main screen includes: 

1 The Menu bar. Gives you access to Symantec Encryption 
Desktop commands. The menus on the Menu bar change 
depending on which Control box is selected. 

2 The PGP Keys Control Box. Gives you control of PGP Keys. 

3 The PGP Messaging Control Box. Gives you control over 
PGP Messaging. 

4 The PGP Zip Control Box. Gives you control of PGP Zip, as 
well as the PGP Zip Assistant, which helps you create new PGP 
Zip archives. 

5 The PGP Disk Control Box. Gives you control of PGP Disk. 

6 The PGP Viewer Control Box. Gives you the ability to 
decrypt, verify, and display messages outside the mail stream. 

7 The Symantec File Share Encryption Control Box. Gives 
you control of Symantec File Share Encryption. 

8 PGP Keys Find box. Use to search for keys on your keyring. 
As you type text in this box, Symantec Encryption Desktop 
displays search results based on either name or email address. 

9 The Symantec Encryption Desktop Work area. Displays 
information and actions you can take for the selected Control 
box. 

Each Control box expands to show available options, and 
collapses to save space (only the Control Box banner displays). 
Expand a Control Box by clicking its banner. 
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Using Symantec Desktop Email 
Encryption 

Symantec Desktop Email Encryption automatically and 
transparently encrypts and signs outgoing messages and 
decrypts and verifies incoming messages. All you need to do is 
to send and receive your email just as you always have; 
Symantec Desktop Email Encryption will take care of the rest. 
 

Sending Encrypted Email 
After installation, Symantec Desktop Email Encryption 
inserts itself between your email client and your mail server 
and watches your email traffic. 

When incoming messages arrive, Symantec Desktop Email 
Encryption intercepts them before they get to your inbox and 
automatically attempts to decrypt and verify them; it uses 
your private keys to decrypt and the public keys of others to 
verify. When it is done with your messages, Symantec 
Desktop Email Encryption delivers them to your inbox. 

In most cases, you do not have to do anything special; 
decrypted incoming messages will appear in your inbox just 
like any other incoming messages. 

When you send outgoing messages, Symantec Desktop Email 
Encryption intercepts them on the way to your mail server 
and automatically attempts to encrypt and sign them, based 
on configured policies. 

Again, you do not have to do anything special; just create your 
messages using your email client and send them—Symantec 
Desktop Email Encryption handles everything else. 

Details of how Symantec Desktop Email Encryption 
transparently handles your incoming and outgoing messaging 
is found in the following sections. 
 

Outgoing Messages 
Symantec Desktop Email Encryption handles your outgoing 
email messages based on policies, sets of instructions that can 
be set up to handle any situation. 
 

Incoming Messages 
Symantec Desktop Email Encryption handles incoming 
messages based on their content: 

 Not encrypted or signed. If a message is not encrypted or 
signed, Symantec Desktop Email Encryption just passes it 
along to your email client. You can read the message as is, 
so there is nothing for Symantec Desktop Email 
Encryption to do to it. 

 Encrypted but not signed. If a message is encrypted, 
Symantec Desktop Email Encryption attempts to decrypt 
it so that you can read it. It will look first on your keyring 
for the private key that can decrypt the message. If it 
finds the private key, Symantec Desktop Email 
Encryption uses it to decrypt the message and then 
passes the message to your email client. If it cannot find 
the private key, Symantec Desktop Email Encryption 

passes it to your email client still encrypted.  
 

 Signed but not encrypted. If a message is signed, 
Symantec Desktop Email Encryption attempts to verify 
the signature. It will look at the following locations in 
this order for the appropriate public key: your default 
keying, the keyserver at keys.domain, where domain is 
the domain of the sender of the message, the PGP Global 
Directory (keyserver.pgp.com), any then other configured 
keyservers. If Symantec Desktop Email Encryption finds 
the appropriate public key, it will attempt to verify the 
signature and then pass the message to your email client. 
If it cannot find the appropriate public key, it will pass 
the message to your email client unverified. 

 Encrypted and signed. If a message is encrypted and 
signed, Symantec Desktop Email Encryption will first try 
to find the private key to decrypt the message, then try to 
find the public key to verify it. 

 

 

Default Policies 
Symantec Desktop Email Encryption includes four default 
policies: 

 Mailing List Admin Requests. Administrative requests to 
mailing lists are sent in the clear; that is, not encrypted 
or signed. 

 Mail List Submissions. Submissions to mailing lists are 
sent signed (so they can be authenticated) but not 
encrypted. 

 Require Encryption: [PGP] Confidential. Any message 
flagged as confidential in your email client or containing 
the text “[PGP]” in the subject line must be encrypted to a 
valid recipient public key or it will not be sent. This policy 
gives you a way to easily handle messages that must be 
sent encrypted or not sent at all. 

 Opportunistic Encryption. Specifies that any message 
for which a key to encrypt cannot be found should be sent 
without encryption (in the clear). Having this policy as 
the last policy in the list ensures that your messages will 
be sent (unless you flag the message as Confidential), 
albeit in the clear, even if a key to encrypt it to the 
recipient cannot be found. 

 

 

Creating New Policies 
Symantec Desktop Email Encryption includes the ability to 
create and use new policies in addition to the four default 
policies. You can create policies based on a wide variety of 
criteria. If you are using Symantec Desktop Email Encryption 
in a Symantec Encryption Server-managed environment, your 
messaging policies and other settings may be controlled by 
your organization’s Symantec Encryption Server 
administrator.  

For complete information about how to create and implement 
messaging policies, see the Symantec Encryption Desktop 
User’s Guide. 
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Was My Message Encrypted? 
Because Symantec Desktop Email Encryption does its work 
automatically and transparently, from time to time you may 
find yourself wondering, was my message really sent 
encrypted? The answer is probably yes, but there are ways to 
make certain. 
 

Notifier Alerts 

Notifier alerts are a feature of Symantec Encryption Desktop 
that both tell you what is going on with your messaging and 
give you control over it. 

For example, when you send an encrypted message, the 
Notifier alert appears in the lower right corner of your screen. 
It shows: 

 Subject. 

 Who it is being sent to. 

 Keys found for the recipient. 

 Status of the message. 

To view more information about the message being sent, click 
More. Now you also see: 

 What Symantec Desktop Email Encryption did to the 
message. 

 Who signed the message. 

For more information about Notifiers, see the Symantec 
Encryption Desktop User’s Guide. 

Note: In a Symantec Encryption Server-managed 
environment, your administrator may have specified certain 
notifications settings (for example, whether notifications 
are to be displayed or the location of the notifier). In this 
case, you may not see any notifier messages at all. 

Notifier Alerts on Microsoft Windows 
8/8.1/10 Systems 

Symantec Encryption Desktop notifier alerts appear on the 
Start screen on the Windows 8/8.1/10 style interface. 
Notifiers do not appear if you disable notifications for 
Windows 8/8.1/10 or Symantec Encryption Desktop. For more 
information about Notifiers on Windows 8/8.1/10 systems, 
see the Symantec Encryption Desktop User’s Guide. 
 

PGP Log 

The PGP Log lists a variety of actions that Symantec 
Encryption Desktop is taking to secure your messaging. It 
shows: 

1 That an outgoing message was sent, who sent it, and what 
the subject was. 

2 The time it was encrypted, the email address it was 
encrypted to, and the email address it was sent from. 

 
 

 

Using PGP Viewer 

In normal usage, Symantec Encryption Desktop sits between 
your email client (Mozilla Thunderbird, for example) and your 
email server so that Symantec Encryption Desktop can 
encrypt and sign outgoing messages and decrypt and verify 
incoming messages. When Symantec Encryption Desktop is 
doing this, it is called “in the mail stream.” 

Use PGP Viewer to decrypt, verify, and display messages 
outside the mail stream. 
 

Opening an Encrypted Message or File 
Use PGP Viewer to open (decrypt, verify, and display) 
encrypted message files of the following types: 

 *.pgp: Created by a PGP application. 

 *.eml: Created by Outlook Express or Thunderbird. 

 *.emlx: Created by Apple's Mail.app program on Mac OS X 
systems. 

 *.msg: Created by Microsoft Outlook. 

When PGP Viewer opens an encrypted message, it does not 
overwrite the encrypted text. The original message remains 
intact. 

To decrypt, verify, and display an encrypted message from a 
file 

1 Open PGP Viewer. To do this, select the PGP icon in the 
system tray and then select PGP Viewer or from within 
Symantec Encryption Desktop select the PGP Viewer 
control box. 

2 Click Open File in PGP Viewer or pull down the Viewer 
menu and select Open File in PGP Viewer. The Open 
Message File dialog appears. 

3 In the Open Message File dialog box, navigate to the file 
you want to open, select it, then click Open. PGP Viewer 
decrypts, verifies, and displays the message in a separate 
window. 

Tip: You can drag and drop the file you want to open 
onto the portion of the PGP Viewer windows that 
displays: Drag Email or Files Here. PGP Viewer opens 
the file, decrypts and verifies it, and displays the 
message. 

4 To open another message, click Open Message in the 
toolbar, navigate to the desired file, select it, then click 
Open. PGP Viewer decrypts, verifies, and displays the 
message. A pane on the left side of the PGP Viewer screen 
is displayed so that you can see all open messages. 
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5 To open a pane on the left side of the PGP Viewer window 
or to close the pane if it is open, click the Pane button on 
the toolbar. 

 

 

Copying Email Messages to Your Inbox 
Use PGP Viewer to copy plaintext versions of decrypted 
messages to the inbox of your email client. 

To copy a message to the inbox of your email client 

1 With the message in the PGP Viewer window, click Copy 
to Inbox. The Copy to Inbox confirmation dialog box 
displays the name of the email client to which the 
message will be copied. To change this setting, see the 
PGP Viewer Preferences. 

2 Click OK to continue. If you are copying a message to the 
Mozilla Thunderbird email client for the first time, a 
dialog box displays, advising that you must install an 
add-on. 

Click Yes to install the add-on and follow the on-screen 
instructions or click No. You must be using Thunderbird 
2.0 or greater to install the add-on. 

3 PGP Viewer opens your email client and copies a 
plaintext version of the message to the inbox. 

 

 

Exporting Email Messages 
Use PGP Viewer to export a decrypted message to a file. 

To export a message from PGP Viewer to a file 

1 With the message displayed in the PGP Viewer window, 
click Export. The Export Message File dialog is displayed. 

2 In the Export Message File dialog box, specify the desired 
location, filename, and format for the file, then click 
Save. PGP Viewer saves the file to the specified location. 

 

 

Specifying Additional Options 
Use the Tools button on the PGP Viewer Toolbar (on the far 
right) to specify several PGP Viewer features: 

 Text Encoding: Specify the text encoding format for the 
message currently being displayed by PGP Viewer. 

 Show Remote Images: Display external resources 
(images, CSS style sheets, iframe content, and so on) for 
the message currently being displayed by PGP Viewer. 
You can specify that PGP Viewer automatically displays 
external resources in Preferences. 

 View Message Source: Display the source of the message 
currently being displayed by PGP Viewer. Viewing the 
message source can tell you more information about the 
message. 

 Preferences: Display the PGP Viewer Preferences dialog 
box. 

 

 

Using Symantec File Share Encryption 

The Symantec File Share Encryption feature allows 
authorized users to share protected files. You must first 
create a Protected Folder and specify those users you want to 
be authorized to use the files. 

1 Click Add Folder in the Symantec File Share Encryption 
Control Box. The Select Folder screen appears. 

2 Click Browse, then select the folder you want to protect. 

3 In the Description field, type a description for the 
Protected Folder you are creating or leave blank to use 
the default name. 

4 Click Next. The Add Users screen appears. 

5 To specify users of the files in the Protected Folder, click 
the down arrow icon, select a user, then click Add. 
Remember to add yourself if you want to access the files 
in the Protected Folder. 

Symantec File Share Encryption does not notify users 
that they can access the protected files; it is the 
responsibility of the creator of a new Protected Folder to 
notify users. 

6 To assign roles to each user, right-click the user's name 
and select the role: 

 Admin: Create only one Admin per Symantec File 
Share Encryption protected folder. This role has full 
read/write rights to the folder, can add and remove 
users, assign roles to other users, and can promote 
another user to be the Admin. 

 Group Admin: Create as many Group Admins as you 
need for each Symantec File Share Encryption 
protected folder. This role has full read/write rights 
to the folder, can add and remove users, and assign 
roles to other users. 

 User: Create as many Users as you need for each 
Symantec File Share Encryption protected folder. 
This role has full read/write rights to the folder. 

You can change a user's role at any time after the 
protected folder is created. Click on the protected folder 
in the Symantec Encryption Desktop, and right-click the 
user's name to change the role. 

7 Click Next. The Select Signer screen appears. 

8 Select one private key from the private keys on the local 
keyring and enter the appropriate passphrase (if the 
passphrase is not cached). This key will be used to secure 
the Symantec File Share Encryption configuration 
information for the Protected Folder and the files in it. 

9 Click Next. The Progress screen appears. The files in the 
specified Protected Folder are encrypted and the 
specified users are authorized to use the files. If any files, 
such as system files, were skipped, they are listed here. 

10 Click Finish. 
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Integrating with Symantec Data Loss 
Prevention 
Symantec Data Loss Prevention discovers, monitors, and 
protects confidential data. When integrated with Symantec 
File Share Encryption, Symantec Data Loss Prevention 
performs these actions on endpoint local disks and on 
internal networks, using Symantec File Share Encryption to 
protect (encrypt) sensitive files, without user intervention.  

Symantec Data Loss Prevention uses two methods to identify 
sensitive files, as specified by the Data Loss Administrator: 

 Data in Motion (DIM). This method monitors data that is 
in transit, including data that is copied, moved from or to 
the local disk, or saved. 

 Data at Rest (DAR). This method discovers stationary 
data. 

When Symantec Data Loss Prevention identifies a sensitive 
file, it encrypts the file: 

 Whether or not the file is in a Protected Folder. 

 Using the keys specified by the Data Loss Administrator.  

When Symantec Data Loss Prevention encrypts a file: 

 The keys may or may not be the same keys as those 
defined by the Admin or Group Admin of the protected 
file. 

 The file may be decrypted then re-encrypted if the file is 
already encrypted by Symantec File Share Encryption. 
Decryption requires that the file owner be logged on. 

 Provides the same user interface as files encrypted by 
Symantec File Share Encryption: 

 Displays the same lock icon. 

 Allows you to view the encryption keys associated 
with a file in the Properties dialog box under the 
Symantec File Share Encryption tab. DIM files show 
‘DLP Auto Encrypt’ as the Signing Key; DAR files 
show the KEY ID. For more information, see 
Accessing the Properties of a Protected File or Folder. 

 Allows you to add or remove users from the access 
list if you are the Admin or Group Admin. 

 

 

Using Symantec Drive Encryption to 
Encrypt a Drive 

The Symantec Drive Encryption feature locks down the entire 
contents of your system or an external or USB flash drive you 
specify. 

The encryption algorithm used by Symantec Drive Encryption 
is AES256. The hashing algorithm is SHA-1. FAT16, FAT32, 
and NTFS formatted drives are supported. There is no 
minimum or maximum size. If the drive is supported by the 
operating system (or your hardware BIOS for the boot drive), 
it should work with Symantec Drive Encryption. 

Caution: Symantec Corporation recommends, as a best 
practice, that you back up your data before encrypting your 
disk. 

You can only encrypt, decrypt, or re-encrypt one disk or 
partition at a time. Once you begin an operation on a disk or 
partition, you cannot start encrypting another one until the 
process is complete on the first. You cannot circumvent this 
by pausing the first operation. 

Caution: While your disk is encrypting, do not accept any 
operating system updates if they are offered. If the update 
occurs automatically, do not restart your computer until the 
encryption process has completed. 

1 Click Encrypt Disk or Partition in the PGP Disk Control 
box. 

2 Select the drive or partition to be encrypted. 

Note: On Windows systems booting in UEFI mode, if the 
disk selected for encryption is the boot disk, then ensure 
that the boot disk has a System Partition with more than 
10 MB of free space. 

3 Select Power Failure Safety if you think your system 
could lose power during the encryption process. 

When Power Failure Safety is selected, the encryption 
process can safely resume if it is interrupted. This option 
can cause encryption to take longer to complete. 

4 Click Add User Key to add users who will be able to 
authenticate to the whole disk encrypted drive using 
public-key cryptography. 

If you are encrypting a fixed drive, you can only use a 
PGP keypair on an Aladdin eToken USB token. If you are 
encrypting a partition or a removable (non-fixed) drive, 
you can use any keypair on your system. 

Use this option on Windows systems booting in BIOS 
mode. Token-based authentication is not available on 
Windows systems booting in UEFI mode. 

5 Click New Passphrase User to add users who 
authenticate using a passphrase. Follow the instructions 
displayed in the PGP Disk Assistant dialog boxes. 

For information on supported characters, see "Supported 
Characters for Symantec Drive Encryption Passphrases" 
in the Symantec Encryption Desktop User's Guide. 

If you are encrypting your boot drive, you have the option 
of using your Windows logon passphrase so that you only 
have to enter your credentials once on startup. 

6 Click Encrypt. 

Notes: To encrypt data on floppy disks or CD-RWs, use PGP 
Virtual Disk volumes; do not use Symantec Drive 
Encryption. 
 
You can use the Symantec Drive Encryption feature on a 
dual-boot system, as long as you boot to an operating system 
supported by Symantec Drive Encryption and Symantec 
Drive Encryption is installed. Partition mode supports 
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dual-booting with another operating system (such as Linux) 
as long as you encrypt only your Windows partition. The 
other operating system must be on another, non-encrypted 
partition. 

Backup software works normally with Symantec Drive 
Encryption; any files the software backs up will be decrypted 
before being backed up. 
 

Symantec Drive Encryption Best Practices 
Symantec Corporation recommends the following best 
practices for preparing to encrypt your disk with Symantec 
Drive Encryption. Please follow the recommendations below 
to protect your data during and after encryption. 

Before you encrypt your disk, there are a few tasks you must 
perform to ensure successful initial encryption of the disk. 

 Determine the BIOS mode of the system. Symantec 
recommends that you determine the type of the system 
before you encrypt your disk because Symantec 
Encryption Desktop encrypts boot disks differently 
depending upon the BIOS mode of the system. For more 
information, see "How to Determine if Your Windows 
System is Running in UEFI Mode" in the Symantec 
Encryption Desktop User's Guide. 

 Make sure you are not running a disk compression 
utility on your boot disk. After your disk has been 
encrypted, there are files that must not be compressed in 
order for Symantec Encryption Desktop to work 
correctly. Symantec Corporation recommends that you 
do not compress your boot disk before or after you have 
encrypted it. 

 Determine whether your target disk is supported. 
Symantec Drive Encryption feature protects desktop or 
laptop disks (either partitions, or the entire disk), 
external disks, and USB flash disks. CD-RW/DVD-RWs 
are not supported. See "Supported Disk Types" in the 
Symantec Encryption Desktop User’s Guide for more 
details on what types of disks are supported. 

 Make sure your keyboard type is supported. See 
"Supported Keyboards for Windows 7 or earlier systems" 
or "Supported Keyboards for Windows 8/8.1/10 systems" 
in the Symantec Encryption Desktop User's Guide. 

 Ensure the health of the disk before you encrypt it. If 
Symantec Drive Encryption encounters disk errors 
during encryption, it will pause encryption so you can 
repair the disk errors. However, it is more efficient to 
repair errors before you initiate encryption. For more 
information, see Ensure Disk Health Before Encryption 
(page 8). 

 Back up the disk before you encrypt it. Before you 
encrypt your disk, be sure to back it up so that you won’t 
lose any data if your laptop or computer is lost, stolen, or 
you are unable to decrypt the disk. 

 Create a recovery disk. While the chances are extremely 
low that a master boot record could become corrupt on a 
boot disk or partition protected by Symantec Drive 
Encryption, it is possible. Before you encrypt a boot disk 

or partition using Symantec Drive Encryption, create a 
recovery disk. See Create a Recovery CD (page 9) for 
instructions on how to create a recovery disk. 

 Be certain that you will have AC power for the duration 
of the encryption process. See Maintain Power 
Throughout Encryption (page 9). 

 Run a pilot test to ensure software compatibility. As a 
good security practice, Symantec Corporation 
recommends testing Symantec Drive Encryption on a 
small group of computers to ensure that Symantec Drive 
Encryption is not in conflict with any software on the 
computer before rolling it out to a large number of 
computers. This is particularly useful in environments 
that use a standardized Corporate Operating 
Environment (COE) image. For a list of software known to 
have compatibility issues with Symantec Drive 
Encryption, see Run a Pilot Test to Ensure Software 
Compatibility (page 9). 

 Ensure you have the correct token and drivers. If you 
are using a USB token for authentication to a fixed disk 
protected using Symantec Drive Encryption, make sure 
you have the correct token and you have installed the 
proper driver software. See "Preparing a Smart Card or 
Token to Use For Authentication" in the Symantec 
Encryption Desktop User's Guide. Smart cards and tokens 
can be used on Windows systems booting in BIOS mode 
only. 

 Perform Disk Recovery on Decrypted Disks. Where 
possible, as a best practice, if you need to perform any 
disk recovery activities on a disk protected with 
Symantec Drive Encryption, Symantec Corporation 
recommends that you first decrypt the disk. Do this by 
Disk > Decrypt in Symantec Encryption Desktop, using 
your prepared Symantec Drive Encryption Recovery Disk, 
or by connecting the hard disk via a USB cable to a 
second system and decrypting from that system's 
Symantec Encryption Desktop software. Once the disk is 
decrypted, proceed with your recovery activities. 

 Installing on a Windows Server system. If you are 
installing Symantec Drive Encryption on a Windows 
Server system, go to the the Symantec Knowledgebase 
(http://www.symantec.com/docs/TECH164863) and 
search for TECH149613 for additional best practices 
information. 

 

Ensure Disk Health Before Encryption 

Symantec Corporation deliberately takes a conservative 
stance when encrypting drives, to prevent loss of data. It is 
not uncommon to encounter Cyclic Redundancy Check (CRC) 
errors while encrypting a hard disk. If Symantec Drive 
Encryption encounters a hard drive or partition with bad 
sectors, Symantec Drive Encryption will, by default, pause the 
encryption process. This pause allows you to remedy the 
problem before continuing with the encryption process, thus 
avoiding potential disk corruption and lost data. 

http://www.symantec.com/docs/TECH164863
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To avoid disruption during encryption, Symantec Corporation 
recommends that you start with a healthy disk by correcting 
any disk errors prior to encrypting. 

 Before you attempt to use Symantec Drive Encryption, 
use a third-party scan disk utility that has the ability to 
perform a low-level integrity check and repair any 
inconsistencies with the drive that could lead to CRC 
errors. Microsoft Windows' check disk (chkdsk.exe) 
utility is not sufficient for detecting these issues on the 
target hard drive. Instead, use software such as SpinRite 
or Norton Disk DoctorTM. These software applications can 
correct errors that would otherwise disrupt encryption. 

 As a best practice, highly fragmented disks should be 
defragmented before you attempt to encrypt them. 

Note: If you are using Symantec Encryption Desktop in a 
Symantec Encryption Server-managed environment, the bad 
sectors encountered during encryption are logged to the 
Symantec Encryption Server and the encryption process 
continues. 
 

Create a Recovery CD 

The following instructions use Roxio software for illustration 
purposes. The actual steps you perform may differ. 

1 Make sure Symantec Encryption Desktop and Roxio Easy 
Media Creator or Roxio Easy CD Creator (or other 
software that can create a CD from an ISO image) are 
installed on your system. 

2 Open Roxio Easy Media Creator or Roxio Easy CD Creator 
and choose to create a Data CD Project. 

3 Select File > Record CD from CD Image. 

4 From the Files of Type menu, select ISO Image Files 
(ISO). 

5 Navigate to the PGP directory. The default location is 
C:\Program Files\PGP Corporation\PGP Desktop 

6 Select bootg.iso and click Open. 

7 Insert a blank, recordable CD into a CD drive on your 
system. 

8 On the Record CD Setup screen, click Start Recording. 

9 When the file is burned to the CD, click OK. 

10 Remove the recovery CD from the drive and label it 
appropriately. 

Caution: Symantec Drive Encryption recovery disks are 
compatible only with the version of Symantec Encryption 
Desktop that created the recovery CD. For example, if you 
attempt to use a 9.0.x recovery disk to decrypt a disk 
protected with Symantec Drive Encryption 10.4 software, it 
will render the disk inoperable. 
 

Maintain Power Throughout Encryption 

Because encryption is a CPU-intensive process, encryption 
cannot begin on a laptop computer that is running on battery 
power. The computer must be on AC power. If a laptop 
computer goes on battery power during the initial encryption 
process (or a later decryption or re-encryption process) 
Symantec Drive Encryption pauses its activity. When you 
restore AC power, the encryption, decryption, or 
re-encryption process resumes automatically. 

Regardless of the type of computer you are working with, 
your system must not lose power, or otherwise shut down 
unexpectedly, during the encryption process, unless you have 
selected the Power Failure Safety option. 

Do not remove the power cord from the system before the 
encryption process is over. If loss of power during encryption 
is a possibility—or if you do not have an uninterruptible power 
supply for your computer—consider choosing the Power 
Failure Safety option, as described in the Symantec Encryption 
Desktop User’s Guide. 

Caution: This holds true for removable disks, such as USB 
devices. Unless you have selected the Power Failure Safety 
option, you run the risk of corrupting the device if you 
remove it during encryption. 
 

Run a Pilot Test to Ensure Software 
Compatibility 

Certain other disk protection software is incompatible with 
Symantec Drive Encryption and can cause serious disk 
problems, up to and including loss of data. Please note the 
following known interoperability issues, and please review 
the Symantec Encryption Desktop Release Notes for the latest 
updates to this list. 

Software that is not compatible: 

 Symantec Endpoint Encryption Full Disk 

 Faronics Deep Freeze (any edition) 

 Utimaco Safeguard Easy 3.x 

 Absolute Software's CompuTrace laptop security and 
tracking product. Symantec Drive Encryption is 
compatible only with the BIOS configuration of 
CompuTrace. Using CompuTrace in MBR mode is not 
compatible. 

 Hard disk encryption products from GuardianEdge 
Technologies: Encryption Anywhere Hard Disk and 
Encryption Plus Hard Disk products, formerly known as 
PC Guardian products. 

The following programs co-exist with Symantec Encryption 
Desktop on the same system, but will block the Symantec 
Drive Encryption feature: 

 Safeboot Solo 

 SecureStar SCPP 
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Authenticating at the PGP BootGuard 
Screen 
The PGP BootGuard log-in screen prompts you for the proper 
passphrase for a protected disk or partition for one of two 
reasons: 

 If your boot disk or partition is protected using Symantec 
Drive Encryption, you must authenticate correctly for 
your system to start up. This is required because the 
operating system files that control system startup are 
encrypted, and must be decrypted before they can be 
used to start up the system. The PGP Single Sign-On 
feature also logs into Windows for you, if you chose the 
SSO option when you first encrypted the boot disk or 
partition. 

 If a secondary fixed disk or partition is protected using 
Symantec Drive Encryption, you can authenticate at 
startup so that you don’t have to authenticate later when 
you need to use files on the secondary disk or partition. 
Because the files on the secondary (non-boot) disk or 
partition are not required for startup, you are not 
required to authenticate at startup. If you do not 
authenticate at startup, you are asked to authenticate 
later, when you try to use the files on the secondary disk 
or partition.  

On the PGP BootGuard log-in screen you can: 

 Authenticate to an encrypted boot or secondary disk or 
partition on the system. 

 View information about the disks or partitions on your 
system. Available on Windows systems running in BIOS 
mode. 

 Choose your keyboard layout. 

If you are using Symantec Encryption Desktop in a Symantec 
Encryption Server-managed environment, your Symantec 
Encryption Server administrator may have customized the 
Symantec Drive Encryption BootGuard screen to include 
additional text or a custom image such as your organization's 
logo. Your actual login screen may look different if your 
administrator has customized the screen. 

To authenticate using the PGP BootGuard log-in screen 

1 Start or restart the system that has a disk or partition 
protected by Symantec Drive Encryption. On startup, the 
PGP BootGuard log-in screen is displayed. 

2 Type a valid passphrase or Windows password and press 
Enter. 

If local self recovery has been configured and you have 
forgotten your passphrase, select Forgot Passphrase. For 
more information, see "If You Forgot Your Passphrase" in 
the Symantec Encryption Desktop User's Guide.  

Note: Token authentication in PGP BootGuard requires 
pressing Ctrl+Enter instead of just Enter. You may also 
experience some delay during the authentication of 
tokens in PGP BootGuard. For Windows systems booting 

in UEFI mode, token-based authentication is not 
available.  

3 If you typed a valid passphrase, the PGP BootGuard log-in 
screen goes away and the system boots normally. 

When you first encrypted the boot disk, if you chose to 
use your Windows Account Logon to authenticate, the 
Symantec Drive Encryption feature logs into Windows 
for you. You only need to type your passphrase once. 

If you typed an invalid passphrase, an error message is 
displayed. Try typing the passphrase again. 

Creating PGP Virtual Disk Volumes 

The PGP Virtual Disk Volumes feature uses part of your hard 
drive space as an encrypted virtual disk volume with its own 
drive letter. You can create additional users for a volume so 
that people you authorize can also access the volume. 

1 Click New Virtual Disk in the PGP Disk Control box. 

2 Type a Name for the volume. 

3 Specify a Disk File Location for the volume. 

4 To specify your mount preferences, do the following: 

 select a drive letter for the volume to Mount as. 

 select Mount at Startup to have your new volume 
mount automatically at startup. 

 select Unmount when inactive for x mins to have the 
volume automatically unmount when it has been 
inactive for the specified number of minutes. 

5 From Capacity, select Dynamic (resizeable) if you want 
the volume to grow in size as you add files or Fixed size if 
you want the volume to always remain the same size. 

6 Specify a file system Format for the volume. 

7 Specify an Encryption algorithm for the volume. 

8 Click Add User Key to add users who authenticate using 
public-key cryptography or click New Passphrase User to 
add users who authenticate using passphrases. 

9 Click Create. 
 

Use the User Access section to control existing users of a PGP 
Virtual Disk volume: 

1 Click Add User Key to add users who authenticate using 
public-key cryptography. 

2 Click New Passphrase User to add users who 
authenticate using passphrases. 

3 Select a passphrase user, then click Change Passphrase 
to change their passphrase. 

4 Select a user, then click Make Admin to give the user 
administrative rights. 

5 Select a user, then click Delete to delete the user. 
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Creating a PGP Zip Archive 

PGP Zip archives let you put any combination of files and 
folders into a compressed, portable archive. There are four 
kinds of PGP Zip archives: 

 Recipient keys. Encrypts the archive to public keys. Only 
the holder of the corresponding private keys can open the 
archive. This is the most secure kind of PGP Zip archive. 
Recipients must be using PGP software (for Windows or 
Mac OS X). 

 Passphrase. Encrypts the archive to a passphrase, which 
must be communicated to the recipients. Recipients must 
be using PGP software (for Windows or Mac OS X). 

 PGP Self-Decrypting Archive. Encrypts the archive to a 
passphrase. Recipients do not need to be using PGP 
software to open it, but their computer must be running 
Microsoft Windows. The passphrase must be 
communicated to the recipients. 

 Sign only. Signs the archive but does not encrypt it, 
allowing you to prove you are the sender. Recipients must 
be using PGP software (for Windows or Mac OS X) to open 
and verify the archive. 

The Passphrase and Sign only PGP Zip types are described in 
detail in the Symantec Encryption Desktop User’s Guide; they 
are described briefly here. 

1 Click New PGP Zip in the PGP Zip Control Box. 

2 Drag and drop the files/folders you want to be in the 
archive or use the buttons to select them. 

3 Select Shred originals if you want the files/folders you 
put into the archive to be shredded when the archive is 
created. 

4 Click Next. 

5 Select the desired kind of PGP Zip archive: 

 Recipient keys 

 Passphrase 

 PGP Self-Decrypting Archive 

 Sign only 

6 Click Next. 

Passphrase and Sign only are described in detail in the 
Symantec Encryption Desktop User’s Guide. 

Refer to the appropriate section on the following pages for the 
kind of PGP Zip archive you specified. 
 

Recipient Keys 
The Add User Keys screen appears. 

1 Click Add and use the User Selection screen to select the 
public keys of those persons who you want to be able to 
open the archive. If you want to be able to open the 
archive yourself, be sure to include your public key. 

2 Click Next. 

3 Choose a private key on the local system to use to sign 
the archive. 

4 Specify a name and a location for the archive. The default 
name is the name of the first file or folder in the archive; 
the default location is the location of the files/folders 
going into the archive. 

Tip: When specifying a file name, do not use the word 
"attachment" or "message" in the file name. When you 
open the .zip file with these words in the file name, PGP 
Viewer attempts to open the file instead of PGP Zip and 
the file fails to open correctly. 

5 Click Next. The PGP Zip archive is created. The Finished 
screen displays information about the new archive. 

6 Click Finish. 

Note: The Passphrase type of PGP Zip archive is very similar 
to Recipient Keys, the difference being that a passphrase is 
used to protect the archive instead of a key. 

Note: The Sign only type of PGP Zip archive is similar to 
Recipient Keys, the difference being that because the archive 
is only signed, not encrypted, you do not select public keys. 
 

PGP Self-Decrypting Archive 
The Create a passphrase screen appears. 

1 Type a passphrase for the PGP Zip Self-Decrypting 
Archive (SDA), then type it again to confirm it. 

2 Click Next. 

3 Choose a private key on the local system to use to sign 
the archive. 

4 Specify a name and a location for the archive. The default 
name is the name of the first file or folder in the archive; 
the default location is the location of the files/folders 
going into the archive. 

Tip: When specifying a file name, do not use the word 
"attachment" or "message" in the file name. When you 
open the .zip file with these words in the file name, PGP 
Viewer attempts to open the file instead of PGP Zip and 
the file fails to open correctly. 

5 Click Next. The PGP SDA is created. 

6 Click Finish. 
 

 

Using PGP Shredder to Shred Files 

The PGP Shredder feature completely destroys files and 
folders so that even sophisticated file recovery software 
cannot recover them. While both the PGP Shredder icon and 
the Windows Recycle Bin appear on your desktop, only PGP 
Shredder immediately overwrites the files you specify so that 
they are not recoverable. 

You can shred files using any of the following methods: 

 Using the PGP Shredder icon. 

 Using the PGP toolbar. 
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 Using the shortcut menu. 

 

 

Shredding Files Using the PGP Shredder 
Icon 

To shred files using the PGP Shredder icon 

1 On your Windows desktop, drag the files and folders you 
want to shred into the PGP Shredder. A dialog box 
appears, asking you to confirm you want to shred the 
files. 

2 Click Yes. The specified files and folders are shredded. 

 
 

 

Shredding Files Using the PGP Toolbar 

To shred files using the PGP Toolbar 

1 In the Symantec Encryption Desktop main application 
window, select Tools > Shred Files. The Open dialog box 
is displayed. 

2 Select the files on your system you want to shred, then 
click Open. A confirmation dialog box is displayed, asking 
you to confirm that you want to shred (secure delete) the 
listed files and/or folders. 

3 Click Yes. The files are securely deleted from your 
system. 

 

 

Shredding Files Using the Shortcut Menu 

To shred files in Windows Explorer 

1 In Windows Explorer, right-click files/folders you want to 
shred.  

2 In the shortcut menu, select Symantec Encryption 
Desktop > PGP Shred [file name or number of items 
selected]. 

3 In the confirmation dialog box, click Yes. The files are 
securely deleted from your system. 

Note: If you do not use the PGP Shredder feature often, you 
can remove the PGP Shredder icon from your desktop via 
PGP Options. To do this, select Tools > Options, select the 
Disk tab, deselect the Place PGP Shredder icon on the 
desktop option, and then click OK. 

Note: You can also use PGP Options to control the number of 
passes made when shredding (more passes is more secure 
but takes longer), whether files in the Windows Recycle Bin 
should be shredded when you empty it, and whether the 
warning dialog box is displayed when you shred. 
 

Shredding Free Space 
The PGP Shredder Free Space feature completely shreds free 
space on your drives so that your deleted data is truly 
unrecoverable. Keep in mind that “free space” is actually a 
misnomer. What PGP Shredder Free Space does is overwrite 
the portions of your hard drive that Windows believes to be 
empty; in fact, that space could be empty or it could be 
holding files Windows told you were deleted. 

When you put files into the Windows Recycle Bin and empty 
it, the files are not really deleted; Windows just acts like there 
is nothing there and eventually overwrites the files. Until 
those files are overwritten, they are easy for an attacker to 
recover. PGP Shredder Free Space overwrites this “free space” 
so that even disk recovery software cannot get those files 
back. 

To shred free space on your disks 

1 Open Symantec Encryption Desktop. 

2 Select Tools > Shred Free Space. 

3 On the Introduction screen, read the information, then 
click Next. 

4 On the Gathering Information screen, in the Shred drive 
field, select the disk or volume you want shredded and 
the number of passes you want PGP Shredder Free Space 
to perform. 

The recommended guidelines for passes are: 

 3 passes for personal use. 

 10 passes for commercial use. 

 18 passes for military use. 

 26 passes for maximum security. 

5 Choose whether to Shred NTFS internal data structures 
(not available on all systems), then click Next. 

This option shreds small (less than 1K) files in internal 
data structures that might otherwise not get shredded. 

6 On the Perform Shred screen, click Begin Shred. 

Note: Click Schedule to schedule a shred of your free 
space instead of doing it now. The Windows Task 
Scheduler must be installed on your system. 

The length of the shred session depends on the number 
of passes you specified, the speed of the processor, how 
many other applications are running, and so on. 

7 When the shred session is complete, click Next. 

8 On the Completing screen, click Finish. 
 

 

Technical Support 

Symantec Technical Support maintains support centers 
globally. Technical Support’s primary role is to respond to 
specific queries about product features and functionality. The 
Technical Support group also creates content for our online 
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Knowledge Base. The Technical Support group works 
collaboratively with the other functional areas within 
Symantec to answer your questions in a timely fashion. For 
example, the Technical Support group works with Product 
Engineering and Symantec Security Response to provide 
alerting services and virus definition updates.  

Symantec’s support offerings include the following: 

A range of support options that give you the flexibility to
select the right amount of service for any size
organization

Telephone and/or web-based support that provides rapid
response and up-to-the-minute information

Upgrade assurance that delivers software upgrades

Global support purchased on a regional business hours or
24 hours a day, 7 days a week basis

Premium service offerings that include Account
Management Services

For information about Symantec’s support offerings, you can 
visit our website at the following URL:  

https://support.symantec.com/content/unifiedweb/en_US/co
ntact-support.html  

All support services will be delivered in accordance with your 
support agreement and the then-current enterprise technical 
support policy.  

Contacting Technical Support 
Customers with a current support agreement may access 
Technical Support information at the following URL:  

https://support.symantec.com/content/unifiedweb/en_US/co
ntact-support.html  

Before contacting Technical Support, make sure you have 
satisfied the system requirements that are listed in your 
product documentation. Also, you should be at the computer 
on which the problem occurred, in case it is necessary to 
replicate the problem.  

When you contact Technical Support, please have the 
following information available: 

Product release level

Hardware information

Available memory, disk space, and NIC information

Operating system

Version and patch level

Network topology

Router, gateway, and IP address information

Problem description:

Error messages and log files

Troubleshooting that was performed before
contacting Symantec

Recent software configuration changes and network
changes

Licensing and Registration 
If your Symantec product requires registration or a license 
key, access our technical support web page at the following 
URL:  

https://support.symantec.com/content/unifiedweb/en_US/co
ntact-support.html

Customer Support 
Customer support information is available at the following 
URL:  

https://support.symantec.com/content/unifiedweb/en_US/co
ntact-support.html

Customer Support is available to assist with non-technical 
questions, such as the following types of issues: 

Questions regarding product licensing or serialization

Product registration updates, such as address or name
changes

General product information (features, language
availability, local dealers)

Latest information about product updates and upgrades

Information about upgrade assurance and support
contracts

Information about the Symantec Buying Programs

Advice about Symantec's technical support options

Nontechnical presales questions

Issues that are related to CD-ROMs or manuals

Support Agreement Resources 
If you want to contact Symantec regarding an existing 
support agreement, see 
https://support.symantec.com/content/unifiedweb/en_US/co
ntact-support.html. 

Copyright and Trademarks 

Copyright (c) 2018 Symantec Corporation. All rights reserved. 
Symantec, the Symantec Logo, the Checkmark Logo, PGP, 
Pretty Good Privacy, and the PGP logo are trademarks or 
registered trademarks of Symantec Corporation or its 
affiliates in the U.S. and other countries. Java is a registered 
trademark of Oracle and/or its affiliates. Other names may be 
trademarks of their respective owners. Export of this product 
may be restricted by the U. S. government. 
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